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Metabolic Case Study Modeling MRI Data in Tumors 

 
Dynamic Contrast-Enhances MRI Analysis of Tumor Data 

 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” It will be 
useful to have worked through the Using SAAM II tutorial “Using Forcing 
Functions.” 

 
What you will learn in this case study 
 
You will learn how to define a model of capillary permeability and fit it to a set of data 
obtained during DEC-MRI. 
 

• How to create a forcing function for blood concentration 
• How to define alternative model parameterizations 
• How to write reports 

 
Data Required 
 

The data file for this case study is 
 

MRI.dat 
 
This data file is a text file. The contents of this file are included at the end of this 
case study. 

 
Introduction 
 
This case study will show you how to implement a model for dynamic contrast-enhanced 
MRI data in tumors. More specifically, it will deal with an experimental protocol in 
which signal intensity from a dynamic contrast-enhanced magnetic resonance imaging 
(DCE-MRI) protocol using Gd-DTPA albumin in an animal model of mammary tumors 
was carried out. Measurements have been made in blood and on the tumor rim. The goal 
will be to develop an integrated model that accounts for blood and the tumor rim, and 
permits estimation of parameters related to capillary permeability. 
 
In terms of SAAM II, there will be two models. One will describe the blood data, and the 
other the tumor rim data. The blood data will be used as a forcing function to drive the 
tumor rim system. 
 
The model equations which will be implemented in the SAAM II setting are given below. 
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 Notation 
 
• q1(t) is contrast agent concentration in blood (mg cc-1), 
• k01 the rate of disappearance of contrast agent concentration from blood (min-1), 
• ICB is the initial concentration pulse of contrast agent in blood (mg cc-1), 
• fBV is fractional blood volume (ml cc-1 of tissue) 
• q2(t) is contrast agent concentration in plasma (mg cc-1), 
• q3(t) is contrast agent concentration in tumor tissue (mg cc-1 of tissue), 
• s1(t) and s2(t) are measured contrast agent concentrations in blood and tissue 

respectively (mg cc-1 and mg cc-1 of tissue). 
 
 The blood model (time in minutes): 

 

 )t(ICB)t(qk
dt

)t(dq
101

1 δ+⋅−=  (1) 

 )t(q)t(s 11 =  
 
In this model, q1 represents the blood compartment which decays monoexponentially 
following a bolus injection of contrast agent, and s1 is the sample equation. 
 
 The tumor rim model 
 
 )()( 12 tqfBVtq ⋅=  

 )t(qk
dt

)t(dq
232

3 ⋅=  (2) 

 )t(q)t(q)t(s 322 +=  
 
In this model, you can see how q2 is defined from q1; this will be specified in SAAM II 
using the forcing function machinery. Compartment q3 represents the tumor rim which, 
because there is no loss, accumulates contrast agent during the experiment. Of interest is 
the measurement equation s2 which contains a term for blood and tissue. 
 
Parameters to be estimated from data are k(0,1), fBV, ICB and k(3,2). An important 
derived parameter is permeability, calculated as PS=fBV(1-H) k(3,2), where H is the 
hematocrit. The produce fBV(1-H) is thus a measure of fractional plasma volume.    
 
1. Daldrup H., Shames D., Wendland M., Okuhata Y., Link T., Rosenau W., Lu Y. and 

Brasch R.. Correlation of dynamic contrast-enhanced magnetic resonance imaging 
with histologic tumor grade: comparison of macromolecular and small-molecular 
contrast media. Pediatr. Radiol. 28: 67-78, 1998. 
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Part 1.  Create a one-compartment model for the blood data using the SAAM II 
Compartmental application. 

 
This part of the case study will show you how to implement the blood model 
 

 )t(ICB)t(qk
dt

)t(dq
101

1 δ+⋅−=  (3) 

 )t(q)t(s 11 =  
 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 
 

2. Create the following system model on the Drawing Canvas. 
 

 
In creating this model, you will need to open the Compartment Attributes 
dialog box by double-clicking on Compartment 1, typing “Blood” in the 
Reference Name box, and clicking Done. 

 
3. Create the experiment for the blood model. 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes 
dialog box will open. 

 
b. Be sure the entry in the Units box is minutes. 
 
c. Enter “59” in the End At box. The Experiment Attributes dialog box will 

appear as follows: 
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d. Click Done. The Create Experiment dialog box will open as follows: 
 

 
 
e. Click Create. Your model will appear as follows: 
 

 
 

4. Add the data to your model. 
 

a. On the Show menu, click Data, or alternatively click Data  on the SAAM 
II Toolbar. The Data window will open. 

 
b. On the File menu, click Open. The file MRI.dat should appear in the list (if it 

does not, find the folder where you have installed this data file). 
 

c. Double-click MRI.dat. The data in this file will appear in the Data window 
as follows: 

 

©University of Washington MRI - 4 Rev. 03/06/19 



Metabolic Case Study Modeling MRI Data in Tumors 

 
 

Notice there are two columns of data, one for blood and the other for the 
tumor rim (tumorrim). 

 
d. Close the Data window. 

 
5. Create the blood sample. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click compartment q1 and then click on the Drawing Canvas. The sample s1 

will appear. 
 

c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “Blood” in the Associate with Data Name box.  
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e. Be sure the sample equation reads “s1=q1”; there should be no need to edit the 

sample equation. The Sample Attributes dialog box will appear as follows: 
 

 
 
f. Click Done. 

 
6. Create an input into Compartment q1. 
 

a. In the SAAM II Toolbox, click Input. 
 
b. Click compartment q1, and then click on the Drawing Canvas. The input ex1 

will appear. 
 
c. Double-click ex1 to open the Exogenous Input dialog box. 
 
d. Type “Input” in the Name box. 
 
e. In the Input Type pane, select Equation. 
 
f. In the Equation box, type “Input=ICB”. 
 
g. Be sure “0” is entered in the Event Start and Event Stop boxes. 
 
h. Click Add. The Exogenous Input dialog box will appear: 
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i. Click Done. Your model will appear as follows: 
 

 
 
 
 

 The equation input. The experimental input in this case is an equation. By 
starting and stopping at time zero, it is essentially a bolus. “ICB” becomes a 
parameter which, in this case, will be estimated from the data. The equation 
input is what allows one to estimate the amount of material in a bolus 
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injection. Because of the way the model is constructed, this will actually 
represent the amount of contrast agent injected that arrives in the tumor. 

 
 
Part 2.  Create the model of contrast agent tumor tissue kinetics in the SAAM II 

Compartmental application and define the permeability parameter 
 

You have now specified the model for the blood data, the input and the measurement 
equation. We will now specify the model for the tumor rim equations: 
 
 )()( 12 tqfBVtq ⋅=  

 )t(qk
dt

)t(dq
232

3 ⋅=  (4) 

 )t(q)t(q)t(s 322 +=  
 
by creating the following two-compartment model: 
 

 
 

 
1. In the SAAM II Toolbox, click Model to make the Model tools available. Create 

the two-compartment model shown above. The two models (following some re-
arrangement) should appear on the Drawing Canvas as follows: 
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2. In the SAAM II Toolbox, click Experiment. Notice the Experiment Attributes 

dialog box does not open. This is because the attributes have already been 
defined. Your models will appear as follows: 

 

 
 
3. Create the forcing function for Compartment q2. 
 

a. Double-click Compartment q2. The Compartment Attributes dialog box 
will open as follows: 

 

 
 
b. Click Forcing Function…. The Forcing Function dialog box will open as 

shown below. 
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c. In the FF Input from pane, click Equation for q2.FF. 
 
d. In the Equation box, type “q2.FF=q1*fBV”. The Forcing Function dialog 

box will appear: 
 

 
 
d. Click Done to close the Forcing Function dialog box. 
 
e. Click Done to close the Compartment Attributes dialog box. 

 

 The forcing function equation. The forcing function is the blood data as 
described by Compartment q1. The parameter fBV is the fraction of this 
compartment which actually “forces” the tumor rim model. This term is thus 
what drives the differential equation )()( 12 tqfBVtq ⋅= . 

©University of Washington MRI - 10 Rev. 03/06/19 



Metabolic Case Study Modeling MRI Data in Tumors 

 
 

4. Define the second sample for the tumor rim. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click compartment q3, and then click on the Drawing Canvas. The sample s2 

will appear. 
 
c. Double-click s2 to open the Sample Attributes dialog box. 
 
d. Type “Tumorrim” in the Associate with Data Name box. 
 
e. Type “s2 = q3 + q2.FF” in the Equations box. The Sample Attributes dialog 

box will appear: 
 

 
 
f. Click Done. Your models will appear as follows: 
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 Samples. The sample for the tumor rim data includes both tissue and blood. 
The tissue is modeled by compartment q3. However blood is not 
compartment q2, but q2.FF which is the forcing function that describes 
the blood profile. Thus to calculate blood correctly, we must use the 
forcing function description. 

 
 
Part 3. Define the permeability parameters. 
 

1. On the Show menu, click Equations, or alternatively click Equations  on the 
SAAM II Toolbar. The Equations dialog box will open. 

 
2. Type “PS=fBV*(1-.42)*k(3,2)” in the Equations box. The Equations dialog box 

will appear: 
 

©University of Washington MRI - 12 Rev. 03/06/19 



Metabolic Case Study Modeling MRI Data in Tumors 

 
 

3. Close the Equations dialog box. 
 

 The permeability equation. The permeability equation is written as a fraction 
of plasma volume (fBV*(1-0.42)), where 0.42 is the hematocrit, times the rate 
constant k(3,2). This number is usually small, so it can be scaled by writing, 
for example, “fBV*(1-0.42)*k(3,2)*100” which will translate the units from 
“per cc” to “per 100cc”. 

 
 
Part 4. Enter the parameter values, Solve the model, Fit the model to the data and 

view the solution. Write a report describing the Fit. 
 
1. Enter the initial parameter estimates. (These values are typical for an animal 

study.) 
 

a. On the Show menu, click Parameters, or alternatively click Parameters  
on the SAAM II Toolbar. The Parameters dialog box will open. 

 
b. Double-click ICB. 
 
c. Enter “5” in the Value box. 
 
d. Click Save. 
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e. Double-click fBV. 
 
f. Enter “0.1” in the Value box. 
 
g. Click Save. 
 
h. Double-click k(0,1). 
 
i. Enter “0.005” in the Value box. 
 
j. Click Save. 
 
k. Double-click k(3,2). 
 
l. Enter “0.01” in the Value box. 
 
m. Click Save. The Parameters dialog box will appear: 
 

 
 

n. Click Done. 
 

2. Prepare to write a final report. 
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a. On the Compute menu, click Computational Settings. The Computational 
Settings dialog box will open. 

 
b. Select Save Results to Text File box. 
 
c. In the Level pane, be sure Basic is selected. In the File pane, be sure Replace 

is selected. The Computational Settings dialog box will appear: 
 

 
 

d. Click Done. 
 

e. Save the study file. Since report writing relies on the file name of your study 
file, you need to save this SAAM II Compartmental study file. 

 
(1) On the File menu, click Save As. The Save As dialog box will open. 
 
(2) Navigate to where you would like to save the file.  
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(3) In the File Name box, type “CaseStudy_MRI”. An example of the Save 
As dialog box is shown below: 

 

 
 
(4) Click Save. 

 
 

 Report writing. SAAM II provides the capability to write the results from 
your modeling session to a text file which can then be used in report 
writing. When you have selected this option, SAAM II will create a text 
file whose name is the same as the study file; in this case, the text file will 
be named CaseStudy_MRI.  

 
There are three levels depending upon the amount, or detail, of 
information you require.  
 
The add or replace option has the following consequence. If you select the 
add option, every time you solve or fit your model to your data, the results 
are written to the text file. If you select the replace option, every time you 
solve or fit your model to your data, the results will overwrite what was 
written previously. 

 
 
3. Solve the model and view the solution. 
 

a. On the Compute menu, click Solve, or alternatively click Solve  on the 
SAAM II Toolbar. 
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b. On the Show menu, click Plot, or alternatively click Plot  on the SAAM 
II Toolbar. The Plot and Table Variables dialog box will open as follows: 

 

 
 

 
c. Click s1:Blood and s2:Tumorrim to move them to the Current Selection 

pane. 
 
d. Click Done. The plot should appear in linear mode. 
 
e. On the View menu, click Semilog. Your plot will appear: 
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Leave the Plot window open. 
 

4. Fit the model and view the statistics. 
 

a. On the Compute menu, click Fit, or alternatively click Fit  on the SAAM 
II Toolbar. 

 
b. The model should successfully converge. However, it is difficult to visualize 

the plot. 
 

(1) On the Set menu, click Plot/Table Scale. The Plot and Table Scale 
dialog box will open. 

 
(2) In the X Axis pane, click Set. In the Maximum box, enter “60”. 
 
(3) In the Y Axis pane, click Set. In the Minimum box, enter “0.3”. In the 

Maximum box, enter “10”. The Plot and Table Scale dialog box will 
appear: 
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(4) Click Done. Your plot will appear as follows: 
 

 
 

c. View the statistics. On the Show menu, click Statistics, or alternatively click 

Statistics  on the SAAM II Toolbar. Your Statistics window will appear 
as follows: 
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The parameter precision is quite good with the largest coefficient of variation 
being just under 10%. Notice also the input bolus and the permeability parameter 
appear as derived variables which also have their own error estimates. 
 
d. View the Correlation matrix 
 

(1) In the Statistics window, select Correlation Matrix. The Statistics 
window will appear: 
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The correlation matrix is also reasonable with the “highest” correlation 
being 0.89 between ICB and fBV. 

 
(2) Close the Statistics window. 
 

e. If you wish, you can investigate the weighted residuals to see how well your 
model describes your data. These can be used to test for goodness-of-fit using 
the runs test. 

 
f. Close all open windows and dialog boxes. 

 
Quit the SAAM II Compartmental application. Remember you have saved this file 
already, so you can use it again. 

 
 

Essential points to remember 
 
• The model is fit to two curves simultaneously, the blood and tumor tissue time 

courses of macromolecular contrast agent. The relevant parameter here is 
permeability, i.e. the rate at which contrast agent escapes the vasculature. 
Permeability is thought to be related to tumor malignancy. 

• In this model, permeability is a derived parameter. 
 
Modeling notes 
 
This modeling approach is described in detail in the reference: Daldrup H., Shames D., 
Wendland M., Okuhata Y., Link T., Rosenau W., Lu Y. and Brasch R.. Correlation of 
dynamic contrast-enhanced magnetic resonance imaging with histologic tumor grade: 
comparison of macromolecular and small-molecular contrast media. Pediatr. Radiol. 28: 
67-78, 1998. 
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Report Writing 
 
When you activate SAAM II’s report writing capability, SAAM II will create text files 
which you can use to follow what you did every time you Solve or Fit. Below is the basic 
file created following the Fit. Navigate first to where you saved CaseStudy_MRT. There 
you will find a file entitled CaseStudy_MRT.txt. The contents of this file are shown 
below. You can cut and paste parts or all of this file into any application such as Word. 
 
Study Name:  CaseStudy_MRI.stu 
Basic Summary Output 
Date:  05:35 PM, Tuesday, May 13, 2003 
Application:  Compartmental 
Type of Calculation:  Fit 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
 
Computational Settings 
 
Integrator:  Rosenbrock 
Relative Integrator Error:  1.0000e-003  
Variance Model:  Data, Relative 
Derivative:  Forward 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
 
Values at t = 0.0 minutes 
 
Blood                   - 
ICB                    4.801012 
Input.bolus            4.801012 
Input.infusion         0.000000 
PS                     0.000576 
Tumorrim                - 
fBV                    0.100327 
flux(0,1)              0.029167 
flux(3,2)              0.000000 
k(0,1)                 0.006075 
k(3,2)                 0.009893 
q1                     4.801012 
q2                     0.000000 
q2.FF                  0.481670 
q3                     0.000000 
s1                     4.801012 
s1_res                  - 
s1_wres                 - 
s2                     0.481670 
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s2_res                  - 
s2_wres                 - 
t                      0.000000 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
 
Calculated Sample Values and Data 
 
 
          t     Tumorrim       Weight           s2      s2_wres 
 0.000e+000         -            -      4.817e-001         -    
 1.000e+000   4.743e-001   7.688e+003   4.835e-001  -8.104e-001 
 3.000e+000   4.856e-001   7.332e+003   4.871e-001  -1.282e-001 
 5.000e+000   4.805e-001   7.490e+003   4.907e-001  -8.858e-001 
 7.000e+000   4.985e-001   6.959e+003   4.943e-001   3.501e-001 
 9.000e+000   4.845e-001   7.366e+003   4.978e-001  -1.138e+000 
 1.100e+001   5.091e-001   6.673e+003   5.012e-001   6.395e-001 
 1.300e+001   5.131e-001   6.569e+003   5.047e-001   6.819e-001 
 1.500e+001   5.298e-001   6.161e+003   5.080e-001   1.705e+000 
 1.700e+001   5.187e-001   6.427e+003   5.114e-001   5.862e-001 
 1.900e+001   5.136e-001   6.556e+003   5.147e-001  -8.949e-002 
 2.100e+001   5.128e-001   6.576e+003   5.179e-001  -4.162e-001 
 2.300e+001   5.128e-001   6.575e+003   5.211e-001  -6.751e-001 
 2.500e+001   5.273e-001   6.219e+003   5.243e-001   2.334e-001 
 2.700e+001   5.084e-001   6.691e+003   5.275e-001  -1.562e+000 
 2.900e+001   5.344e-001   6.054e+003   5.306e-001   3.000e-001 
 3.100e+001   5.229e-001   6.324e+003   5.336e-001  -8.523e-001 
 3.300e+001   5.283e-001   6.195e+003   5.367e-001  -6.570e-001 
 3.500e+001   5.476e-001   5.767e+003   5.396e-001   6.019e-001 
 3.700e+001   5.567e-001   5.580e+003   5.426e-001   1.050e+000 
 3.900e+001   5.620e-001   5.475e+003   5.455e-001   1.219e+000 
 4.100e+001   5.685e-001   5.349e+003   5.484e-001   1.473e+000 
 4.300e+001   5.736e-001   5.256e+003   5.513e-001   1.619e+000 
 4.500e+001   5.711e-001   5.303e+003   5.541e-001   1.237e+000 
 4.700e+001   5.604e-001   5.506e+003   5.568e-001   2.619e-001 
 4.900e+001   5.590e-001   5.533e+003   5.596e-001  -4.316e-002 
 5.100e+001   5.727e-001   5.272e+003   5.623e-001   7.528e-001 
 5.300e+001   5.589e-001   5.535e+003   5.650e-001  -4.501e-001 
 5.500e+001   5.535e-001   5.643e+003   5.676e-001  -1.059e+000 
 5.700e+001   5.502e-001   5.711e+003   5.703e-001  -1.514e+000 
 5.900e+001         -            -      5.728e-001         -    
 5.900e+001   5.496e-001   5.725e+003   5.728e-001  -1.759e+000 
 
 
          t        Blood       Weight           s1      s1_wres 
 0.000e+000         -            -      4.801e+000         -    
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 1.000e+000   5.300e+000   1.474e+001   4.772e+000   2.026e+000 
 3.000e+000   4.656e+000   1.910e+001   4.714e+000  -2.561e-001 
 5.000e+000   4.631e+000   1.930e+001   4.657e+000  -1.177e-001 
 7.000e+000   4.670e+000   1.898e+001   4.601e+000   2.985e-001 
 9.000e+000   4.399e+000   2.138e+001   4.546e+000  -6.755e-001 
 1.100e+001   4.628e+000   1.932e+001   4.491e+000   6.054e-001 
 1.300e+001   4.337e+000   2.201e+001   4.436e+000  -4.688e-001 
 1.500e+001   4.525e+000   2.022e+001   4.383e+000   6.385e-001 
 1.700e+001   4.350e+000   2.188e+001   4.330e+000   9.306e-002 
 1.900e+001   4.121e+000   2.437e+001   4.278e+000  -7.732e-001 
 2.100e+001   4.304e+000   2.234e+001   4.226e+000   3.703e-001 
 2.300e+001   3.918e+000   2.697e+001   4.175e+000  -1.335e+000 
 2.500e+001   4.201e+000   2.345e+001   4.125e+000   3.718e-001 
 2.700e+001   3.658e+000   3.093e+001   4.075e+000  -2.318e+000 
 2.900e+001   4.019e+000   2.562e+001   4.025e+000  -3.248e-002 
 3.100e+001   3.670e+000   3.074e+001   3.977e+000  -1.703e+000 
 3.300e+001   3.917e+000   2.697e+001   3.929e+000  -5.953e-002 
 3.500e+001   3.959e+000   2.640e+001   3.881e+000   4.001e-001 
 3.700e+001   3.797e+000   2.872e+001   3.835e+000  -2.034e-001 
 3.900e+001   4.090e+000   2.475e+001   3.788e+000   1.499e+000 
 4.100e+001   3.772e+000   2.909e+001   3.742e+000   1.593e-001 
 4.300e+001   3.780e+000   2.897e+001   3.697e+000   4.462e-001 
 4.500e+001   3.857e+000   2.782e+001   3.653e+000   1.078e+000 
 4.700e+001   3.795e+000   2.875e+001   3.609e+000   9.981e-001 
 4.900e+001   3.681e+000   3.055e+001   3.565e+000   6.418e-001 
 5.100e+001   3.600e+000   3.194e+001   3.522e+000   4.396e-001 
 5.300e+001   3.575e+000   3.239e+001   3.479e+000   5.426e-001 
 5.500e+001   3.423e+000   3.532e+001   3.437e+000  -8.247e-002 
 5.700e+001   3.563e+000   3.260e+001   3.396e+000   9.553e-001 
 5.900e+001         -            -      3.355e+000         -    
 5.900e+001   3.032e+000   4.502e+001   3.355e+000  -2.164e+000 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
 
Statistics 
 
Parameter/Variable      Value      Std.Dev.  Coef. of Var.    95% Confidence Interval 
------------------    -------      --------  -------------    ----------------------- 
ICB                   4.80101  8.66002e-002  1.80379e+000       4.62743       4.97460 
fBV                   0.10033  2.08626e-003  2.07947e+000       0.09615       0.10451 
k(0,1)                0.00608  5.21966e-004  8.59178e+000       0.00503       0.00712 
k(3,2)                0.00989  6.82626e-004  6.90035e+000       0.00852       0.01126 
--------------------------------- Derived Variables --------------------------------- 
Input.bolus           4.80101  8.66002e-002  1.80379e+000       4.62743       4.97460 
PS               5.75647e-004  2.98232e-005  5.18081e+000  5.15868e-004  6.35427e-004 
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                          Objective      Scaled Data Variance 
s2 : Tumorrim          -3.896207e+000       5.783175e-002 
s1 : Blood             -1.157392e+000       2.415955e-001 
                       -------------- 
Total objective        -5.053599e+000 
 
AIC                    -1.507861e+000 
BIC                    -1.403144e+000 
 
Number of Iterations Required to Fit: 2 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
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Data for this tutorial 
 
# Sample DCE-MRI data 
DATA 
(FSD 0.1) 
  t      Blood     Tumorrim       
1 5.29961083 0.47426045 
3 4.65569979 0.48563945 
5 4.63058307 0.48049092 
7 4.6696255 0.49846823 
9 4.39949196 0.48451182 
11 4.62838974 0.50906396 
13 4.33651261 0.51306759 
15 4.52485183 0.52975718 
17 4.34981471 0.5186808 
19 4.12100581 0.51356047 
21 4.30431552 0.51279035 
23 3.91790277 0.51281399 
25 4.20128238 0.52727842 
27 3.65794591 0.50836182 
29 4.01907447 0.53441659 
31 3.66961778 0.52290863 
33 3.91738389 0.52830694 
35 3.95927113 0.54757063 
37 3.7965714 0.55665685 
39 4.08961747 0.56199753 
41 3.77200714 0.56854432 
43 3.78016797 0.57358948 
45 3.85692243 0.57105223 
47 3.79465979 0.56037746 
49 3.68105545 0.55901576 
51 3.5996606 0.57267722 
53 3.57467114 0.55894153 
55 3.42344289 0.5535468 
57 3.56310911 0.55022836 
59 3.03221385 0.54959616 
END 
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